
 

SCENARIO 
Mr. Rock Castle, owner of Rock Castle Construction, 
called to hire you as his accountant. His former 
accountant unexpectedly accepted a job offer in 
Hawaii, and Rock Castle Construction needs someone 
immediately to maintain its accounting records. Mr. 
Castle indicates they use QuickBooks to maintain the 
company’s accounting records. When you tell him that 
you are not familiar with QuickBooks software, Mr. 
Castle reassures you, “No problem! QuickBooks is easy 
to learn. Stop by my office this afternoon.” 

When you arrive at Rock Castle Construction, Mr. 
Castle leads you to a cubicle as he rapidly explains 
Rock Castle’s accounting.  

“Rock Castle needs to keep records of transactions with 
customers, vendors, and employees.  We must keep a 
record of our customers and the sales and services we 
provide to those customers. Also, it is crucial for the 
company to be able to bill customers promptly and 
keep a record of cash collected from them. If we don’t 
know who owes Rock Castle money, we can’t collect 
it.  

“Rock Castle also needs to keep track of the supplies, 
materials, and inventory we purchase from vendors. 
We need to track all purchase orders, the items 
received, the invoices or bills received from vendors, 
and the payments made to vendors. If we don't track 
bills, we can’t pay our vendors on time. And if Rock 
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Castle doesn’t pay its bills on time, the vendors don’t 
like to sell to us. 
 
“Also, we like to keep our employees happy.  One way 
to do that is to pay them the right amount at the right 
time. So Rock Castle must keep track of the time 
worked by its employees, the amounts owed to the 
employees, and the wages and salaries paid to them.   
 
“QuickBooks permits Rock Castle to keep a record of 
all of these transactions. Also, we need records so we 
can prepare tax returns, financial reports for bank loans, 
and reports to evaluate the company’s performance 
and make business decisions. 
 
“Your first assignment is to learn more about 
QuickBooks.” Mr. Castle tosses you a QuickBooks 
training manual as he rushes off to answer a phone 
call. 
 
Slightly overwhelmed by Mr. Castle’s rapid-fire 
delivery, you sink into a chair. As you look around 
your cubicle, you notice for the first time the leaning 
tower of papers stacked beside the computer, waiting 
to be processed. No wonder Mr. Castle wanted you to 
start right way.  
 
Mr. Castle bursts back into your cubicle quickly tossing 
something onto your cluttered desk. “And here’s your 
new company smartphone—that way I can reach you 
anytime I need you!”  
 
Noticing your startled expression, Mr. Castle pauses 
and then reassuringly says, “Don’t worry—IT has 
already set up security for your new phone so that all 
financial communications will be secure.”  
 
Recalling your favorite college professor’s advice, you 
remind yourself to Focus & Work Smarter. Opening the 
QuickBooks training manual, you see the following 
page.   
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In Chapter 1, you will learn about the following 
QuickBooks features: 

n Install QuickBooks .............................................. 1.9 

n Start QuickBooks ................................................ 1.9 

n Open Company .................................................. 1.9 

n Change Company Name ................................... 1.15 

n QuickBooks Navigation .................................... 1.16 

n Home Page  ...................................................... 1.16 

n QuickBooks Icon Bar ........................................ 1.22 

n QuickBooks Menus ........................................... 1.30 

n QuickBooks Reports ......................................... 1.39 

n QuickBooks Help Menu ................................... 1.43 

n Save Company Files .......................................... 1.46 

n QuickBooks Backup (.QBB) Files ...................... 1.49 

n Close Company ................................................ 1.53 

n Exit QuickBooks ............................................... 1.53 
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ACCOUNTING INFORMATION SYSTEMS 
 
QuickBooks is accounting software that provides an easy and 
efficient way to collect and summarize accounting information. In 
addition, QuickBooks creates many different reports that are useful 
when managing a business. 

The objective of an accounting system is to collect, summarize, and 
communicate information to decision makers. Accounting 
information is used to: 

§ Prepare tax returns for federal and state tax agencies.  

§ Prepare financial statements for banks and investors. 

§ Prepare reports for managers and owners to use when making 
decisions. Such decisions include: Are our customers paying their 
bills on time? Which of our products are the most profitable? Will 
we have enough cash to pay our bills next month? 

TRANSACTIONS 
An accounting system collects information about transactions. As a 
company conducts business, it enters into transactions (or exchanges) 
with other parties such as customers, vendors, and employees. For 
example, when a business sells a product to a customer, there are 
two parts to the transaction:  
1. The business gives a product to the customer. 
2. In exchange, the business receives cash (or a promise to pay later) 

from the customer. 
 

  

Accounting is 
the language of 
business. 
Learning 
accounting is 
similar to 
learning a 
foreign 
language. As 
you use this 
text, you will 
learn terms and 
definitions that 
are unique to 
accounting. 
 

Business	
 

Customer	
 
Product	
 Cash	
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DOUBLE-ENTRY ACCOUNTING 
Double-entry accounting has been used for over 500 years. In Italy in 
the year 1494, Luca Pacioli, a Franciscan monk, wrote a mathematics 
book that described double-entry accounting. At that time, the 
merchants of Venice used the double-entry system to record what 
was given and received when trading. 	
  

Double-entry accounting is used to record what is exchanged in a 
transaction:  

1. The amount received, such as equipment purchased, is recorded 
with a debit. 

2. The amount given, such as cash or a promise to pay later, is 
recorded with a credit.  

Each entry must balance; debits must equal credits. In a manual 
accounting system, accountants make debit and credit entries in a 
Journal using paper and pencil. When using QuickBooks for your 
accounting system, you can enter accounting information in two 
different ways: (1) onscreen Journal, and (2) onscreen forms.  

1.  Onscreen Journal. You can make debit and credit entries in an 
onscreen Journal shown below. Notice the similarities between 
the onscreen Journal and a manual Journal. 

	
  

For a debit and 
credit refresher, 
see Chapter 3. 
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Instead of using the onscreen Journal, you can use onscreen 
forms to enter information in QuickBooks.   

2.  Onscreen forms. You can enter information about transactions 
using onscreen forms such as the onscreen check and the 
onscreen invoice shown below.  

 
 
	
  
	
  
	
   	
   	
   	
   	
   	
   	
   	
   	
   	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
	
   	
   	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
QuickBooks automatically converts information entered in onscreen 
forms into double-entry accounting entries with debits and credits. 
QuickBooks maintains a list of journal entries for all the transactions 
entered—whether entered using the onscreen Journal or onscreen 
forms. 
 

	
  
	
  
	
  

When writing a check, QuickBooks 
provides an onscreen check to record the 
check information. 

When preparing a customer’s bill, record 
the information in an onscreen invoice. 
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QUICKBOOKS ACCOUNTING SYSTEM 
	
  
Steps to create an accounting system using QuickBooks are: 

Step 1: Set up a new company data file. QuickBooks uses an 
EasyStep Interview that asks you questions about your 
business. QuickBooks then automatically creates a 
company data file for your business. In Section 1 of this 
text, Exploring QuickBooks with Rock Castle Construction, 
you will use a sample company data file that has already 
been created for you.  In Section 2, you will set up a new 
company using the EasyStep Interview. To learn how to set 
up a company file, see Chapter 8.  

 
Step 2: Create a Chart of Accounts. A Chart of Accounts is a list of 

all the accounts for a company. Accounts are used to sort 
and track accounting information. For example, a business 
needs one account for cash, another account to track 
amounts customers owe (Accounts Receivable), and yet 
another account to track inventory. QuickBooks 
automatically creates a Chart of Accounts in the EasyStep 
Interview. QuickBooks permits you to modify the Chart of 
Accounts later, after completing the EasyStep Interview. 

 
Step 3: Create lists. QuickBooks uses lists to record and organize 

information about:  

§ Customers. 

§ Vendors. 

§ Items (items purchased and items sold, such as 
inventory). 

§ Employees. 

§ Other (such as owners). 
 

Step 4: Enter transactions. Enter transaction information into 
QuickBooks using the onscreen Journal or onscreen forms 
(such as onscreen invoices and onscreen checks). 
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Step 5: Prepare reports. Reports summarize and communicate 
information about a company’s financial position and 
business operations. Financial statements are standardized  
financial reports that summarize information about past 
transactions. Financial statements are provided to external 
users, such as bankers and investors. Internal users, such as 
managers, also may use financial statements. The primary 
financial statements for a business are: 

§ Balance Sheet: summarizes what a company owns and 
owes on a particular date. 

§ Profit & Loss Statement (or Income Statement): 
summarizes what a company has earned and the 
expenses incurred to earn the income. 

§ Statement of Cash Flows: summarizes cash inflows and 
cash outflows for operating, investing, and financing 
activities of a business. 

Additional financial reports are used by internal users 
(managers) to assist in making decisions. An example of 
such a report is a cash budget that projects amounts of 
cash that will be collected and spent in the future. 

Section 1: Exploring QuickBooks with Rock Castle Construction 
covers Step 2: creating a Chart of Accounts; Step 3: creating lists; 
Step 4: entering transactions; and Step 5: preparing reports. Section 2: 
QuickBooks Accounting for Entrepreneurs covers how to set up a 
new company in QuickBooks and reviews Steps 2 through 5. 

Input Data Output Reports   
 

QuickBooks 
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!
Register 
your 
QuickBooks 
software! 
Failure to 
register your 
QuickBooks 
trial version 
software will 
result in the 
software no 
longer 
functioning. 

INSTALL QUICKBOOKS 

If you are using the trial version of QuickBooks software that is 
packaged with your text, see Appendix A: Install & Register 
QuickBooks Software for instructions to install and register the 
software. After installing the software, you must register the software 
with Intuit or you will be locked out of the software. If registered, you 
will be able to use the QuickBooks software for 160 days. 

START QUICKBOOKS 

To start QuickBooks software, click the QuickBooks icon on your 
desktop. If a QuickBooks icon does not appear on your desktop, from 
Microsoft® Windows® click Start button > Programs > QuickBooks > 
QuickBooks Premier Accountant Edition 2015. 

OPEN COMPANY 

After starting QuickBooks software, the following Let’s get your 
business set up quickly! window appears. From this screen you can: 

1. Use Express Start to set up a new QuickBooks company file.

2. Use Detailed Start to control the setup and fine-tune a new
QuickBooks company file.

3. Create a new company file based on an existing one.

4. Open an existing QuickBooks company file.

QuickBooks 
Accountant 
2015 software 
is packaged 
with your text. 
QuickBooks 
data files are 
packaged on 
the CD on the 
back cover of 
your text. 

QuickBooks 
Accountant 
2015 includes 
all the features 
of QuickBooks 
Pro plus features 
for client 
services. 
If you use 
QuickBooks 
Pro, your 
screens may 
appear slightly 
different than 
those appearing 
in this text. 
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+ 
To keep your 
Desktop neat, 
consider 
adding a 
Folder to your 
Desktop:  
QBB DATA 
STARTER 
FILES. Then 
copy the QBB 
DATA 
STARTER files 
to that folder. 
 

To open the QuickBooks data file for Chapter 1:  

Step 1: Copy Chapter 1 DATA STARTER.QBB file from the data 
file CD to your desktop. If you prefer, you can download 
the Chapter 1 DATA STARTER.QBB file from the Online 
Learning Center (OLC) to your desktop. 

 

 
Step 2: From the Let’s get your business set up quickly! window, 

select Other Options > Open Existing File.  

If your QuickBooks software has been used before, the 
following window will appear. Select Open or restore an 
existing company.  
 
 

 
 
Step 3: Select Restore a backup copy.  

Step 4: Click Next. 

For your convenience, QuickBooks (.QBB) data files accompany 
Computer Accounting with QuickBooks 2015. You will find the data 
files on the CD packaged on the back cover of your text. Before using 
the data files on the CD, you must copy the files to your desktop. Or 
you can download the data files from the Online Learning Center at 
www.mhhe.com/kay2015. 
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Step 5: When the following Open or Restore Company window 

appears, select Local backup.  

Step 6: Click Next. 

 
Step 7: Identify the location of the Chapter 1 DATA STARTER.QBB 

file. If you copied the Chapter 1 DATA STARTER file to 
your desktop, select the Look in field to find the location of 
the .QBB file on your desktop.  



1.12   Exploring QuickBooks with Rock Castle Construction  

©McGraw-Hill Education, 2016 

Step 8: Select the file: Chapter 1 DATA STARTER.QBB. 

Step 9: The Files of type field should automatically display: QBW 
Backup (*.QBB).  

Step 10: Click Open.  

   

Step 11: When the following window appears, click Next.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Your 
Windows 
settings 
determine 
whether the 
.QBB filename 
extension 
appears after 
the filename. 
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Step 12: Identify the file name and location of the new company 
file (.QBW) file. You can save the .QBW (working file) on 
your desktop. Select the location to save in: Desktop. (Or 
another option is to save your QBW files to Users > Public 
> Public Documents > Intuit > QuickBooks > Company 
Files. Be sure you have permissions to save to a folder.) 

Step 13: File name: YourName Chapter 1. Insert your name in the 
file name so you can identify your files. 

Step 14: The Save as type field should automatically appear as 
QuickBooks Files (*.QBW).  

Step 15: Click Save.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 16: Click OK when the following window appears. 

 
 
 
 
 
 
 

 
QBW files can 
also be saved 
to your 
storage device 
if there is 
adequate 
storage space. 
 

 
If an Update 
Company 
window 
appears, select 
Yes. 
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Step 17: Click OK if the following QuickBooks Information window 
appears. 
 

 
 
 
 
 
 
 
 
Step 18: If the Accountant Center window appears, uncheck Show 

Accountant Center when opening a company file. The 
Accountant Center is a feature for organizing QuickBooks 
accountant tools.  

Step 19: Close the Accountant Center window.  
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CHANGE COMPANY NAME 
 
In order to identify your printouts, add your name to the company 
name. When you create reports and checks, your name will then 
automatically appear on your printouts. 

To change a company name in QuickBooks, complete the following:  

Step 1: From the Menu bar, select Company. 
 
 
 
 
 
 
 
 
 
 

Step 2: Select My Company.  

Step 3: When the following My Company window appears, select 
Edit.  

Step 4: Update the Company Information window, update 
Company Name field to: YourName Chapter 1 Rock 
Castle Construction.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The 
company 
name that 
appears in 
the Title bar 
of the 
QuickBooks 
window 
and on 
reports can 
differ from 
the backup 
company 
filename. 
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Step 5: Close the My Company window.  

QUICKBOOKS NAVIGATION  
 
Taking a few minutes to learn QuickBooks navigation will make 
learning QuickBooks easier. QuickBooks offers three different ways 
to navigate QuickBooks 2015 software: 

§ Home page  

§ Icon bar (My Shortcuts) 

§ Menu bar 
 

 

HOME PAGE 
 
To view the QuickBooks Home page, click the Home icon in the 
Icon bar. The Home page contains the main categories of 
transactions and tasks: 
1. Customer or sales transactions 
2. Vendor or purchase transactions 
3. Employee or payroll transactions 
4. Banking transactions 

Home page: Click the Home 
icon on the Icon bar to reveal 
flowcharts of frequently used 
tasks. 

 

Icon bar: 
Click on icons 
to display 
customer, 
vendor, and 
employee 
centers and 
frequently 
used 
windows, 
such as 
customer 
invoices. 

Menu bar: 
Click on the 
Menu bar to 
reveal a drop-
down menu 
for each area. 
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5. Company tasks 

CUSTOMERS 
The Customers section is a flowchart of the main activities associated 
with sales and customers. You can: 

§ Create estimates. 

§ Create invoices to bill customers. 

§ Record refunds and credits for merchandise returned by 
customers. 

§ Record payments received from customers (cash, check, and 
credit card payments). 

 
          
 
 
 
 
 
 
 

Flowchart of 
customer  
and sales 
transactions. 
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VENDORS 
From the Vendors flowchart, you can record:  

§ Purchase orders (orders placed to purchase items). 

§ Inventory received. 

§ Bills received. 

§ Bills paid.  

§ Sales tax paid. 

 
 
 
 
 
 
 
 
 
 
 
 

Flowchart of 
vendor and 
purchase 
transactions. 
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EMPLOYEES 
From the Employees flowchart, you can:  

§ Enter time worked. 

§ Pay employees. 

§ Pay payroll tax liabilities. 

§ Process payroll forms. 

 
 

 
BANKING 
From the Banking section, you can:  

§ Record deposits. 

§ Write checks. 

§ Reconcile your bank statement. 

§ Open your check register. 

 

Flowchart of 
employee and 
payroll 
transactions. 

 

Access 
Banking tasks 
from this 
section. 
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COMPANY 
From the Company section, you can access: 

§ Chart of Accounts. A list of accounts a company uses to track 
accounting information. 

§ Items & Services. A list of items and services that a company buys 
and/or sells. 

§ QuickBooks Web and Mobile Apps. A QuickBooks service that 
permits you to connect your mobile devices (iOS 
and Android OS) to your QuickBooks data. 

§ Calendar. View your to do list and reminders in a 
calendar form. 

 
 

 
 
 
 
 
 
 

 
Access the 
Chart of 
Accounts from 
the Company 
section. 
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INSIGHTS 
 
A new feature of QuickBooks 2015 is called Insights.  

Select the Insights tab next to the Home Page tab to view a digital 
dashboard of relevant financial data. The digital dashboard can be 
customized for the specific business user. This is a new feature of 
QuickBooks 2015. 



1.22   Exploring QuickBooks with Rock Castle Construction  

©McGraw-Hill Education, 2016 

QUICKBOOKS ICON BAR 
 

The QuickBooks Icon bar with My 
Shortcuts is a toolbar that can be 
customized for frequently used 
activities. The Icon bar can be 
displayed either beneath the Menu bar 
or on the left side of the QuickBooks 
window.   

To display the Icon bar if it does not 
appear on your screen: 

Step 1: Click View on the Menu 
bar. 

Step 2: Select Left Icon Bar. 
 
The Icon bar can be customized to 
display the tasks that you use most 
frequently. To customize the Icon bar: 

Step 1: Click View on the Menu 
bar. 

Step 2: Select Customize Icon Bar. 

Step 3: Reorder the tasks in the 
following order and then 
click the OK button. 

§ Home 

§ My Company 

§ Calendar 

§ Snapshots 

§ Customers 

§ Vendors 

§ Employees 

§ Reports  

§ Docs 

§ App Center  
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To use My Shortcuts for the My Company window:  

Step 1: Select My Company on the Icon bar.  

Step 2: Select Edit to make changes to the My Company window. 

Step 3: Close the My Company window. 
 

 

To use My Shortcuts to access the Income Tracker window: 

Step 1: Select Income Tracker on the Icon bar. 

Step 2: In the Income Tracker window, view summaries of 
amounts for Unbilled, Unpaid, and Paid amounts. 
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To use My Shortcuts to access the Calendar window: 

Step 1: Select Calendar on the Icon bar. 

Step 2: To add a task to the calendar, select Add To Do. 
 

 
 



  Chapter 1  Quick Tour of QuickBooks  1.25 

©McGraw-Hill Education, 2016 

To view and customize snapshots of company information:  

Step 1: Click Snapshots to display summaries of financial 
information about the company, payments, and customers.  

Step 2: To customize the snapshots for specific business 
requirements, select How do I customize this page? 

Snapshots provides an overview, summarizing information 
such as: 

§ Customers Who Owe Money 

§ Vendors to Pay 

§ Account Balances 

§ Reminders of Due Dates and Amounts 

To view the Customer Center: 

Step 1: Click Customers on the Icon bar to display the following 
Customer Center.  

Step 2: Toggle between customer and transaction information.  
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You can also 
access the 
Vendor Center 
by clicking on 
the Vendors 
button in the 
Vendors 
section of the 
Home page. 
 

 

 

 

 

 

 

 

 

 

 

 

 

The Customer Center summarizes information about 
customers, jobs, and customer transactions. The 
information can be printed or exported to Excel or Word.  

To view the Vendor Center:  

Step 1: Click Vendors on the Icon bar to display the Vendor 
Center.  

Step 2: Toggle between vendor and transaction information. 
 

 

 

 

 

 

 

 

 

 

 

 

 
You can also 
access the 
Customer 
Center by 
clicking on 
the Customers 
button in the 
Customers 
section of the 
Home page. 
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The Vendor Center summarizes information about vendors 
and vendor transactions. The information can be printed or 
exported to Excel. 

To view the Employee Center:  

Step 1: Click Employees on the Icon bar to display the Employee 
Center.  

Step 2: From the Employee Center you can toggle between 
employee, transaction, and payroll information. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To view the Doc Center:  

Step 1: Click Docs to display the Doc Center.  

Step 2: Use the Doc Center to add a document from your 
computer or scan a document into QuickBooks. You can 
even attach the document, such as a receipt, to a specific 
transaction. 

 

 

 
You can also 
access the 
Employee 
Center by 
clicking on 
the Employees 
button in the 
Employees 
section of the 
Home page. 
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Contributed 
Reports are 
specialized 
reports shared 
by other 
QuickBooks 
users. 
 

 

 

 

 

 

 

 

To view the Report Center:  

Step 1: Click Reports on the Icon bar to view the Report Center.  

Step 2: You can select from Standard, Memorized, Favorites, 
Recent, or Contributed reports. In a later section of this 
chapter, you will learn how to prepare a report. 
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To display the Intuit App Center: 

Step 1: Select App Center on the Icon bar to view the Intuit App 
Center for organizing apps that work with your 
QuickBooks software and data.  

Step 2: Click Learn more to learn more about apps that connect 
with QuickBooks. 

 

 

 

 

 

 

 

 

 

 

 

 

To move between open windows in QuickBooks: 

Step 1: Select Open Windows on the Icon bar to view all open 
windows. Use this feature when you need to switch back 
and forth between open windows quickly. 

Step 2: Then select the Report Center.  

Step 3: Close all open windows except the Home page. 

 

 

 

 

 

 

 

 
Open Windows is 
a time-saving 
technique to use 
when completing 
your QuickBooks 
assignments. 
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To save time when working in QuickBooks, you can organize and 
arrange My Shortcuts on the Icon bar to suit your specific 
QuickBooks needs. 

QUICKBOOKS MENUS  
 
You can also access tasks using the Menu bar across the top of the 
QuickBooks window.  
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Step 1: Click File on the Menu bar and the following drop-down 
menu will appear.  

 

 

 

 

 

From the File drop-down menu, you can perform tasks 
including the following: 

§ Create a new company file. 

§ Create a new company from an existing company file. 

§ Open or restore an existing company file. 

§ Open a previous company file. 

§ Open a second company file, permitting you to have 
two QuickBooks company files open at the same time. 
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§ Back up your company file. 

§ Create a copy of your company file. 

§ Close a company file. 

§ Switch to multi-user mode when QuickBooks is used 
on a network. 

§ Use utilities such as importing and exporting files. 

§ Send a copy of your QuickBooks company file to your 
accountant. 

QuickBooks output tasks include: 

§ Print or save as a Portable Document Format (PDF) file. 

§ Print Forms for printing forms, such as invoices, sales 
receipts, and tax forms. 

§ Printer Setup to select a printer as well as fonts and 
margins.  

§ Send Forms to email various QuickBooks forms, such 
as sending invoices to customers. 

§ Ship using FedEx, UPS, and USPS.  

In QuickBooks Accountant Edition, the File menu displays 
Toggle to Another Edition. This command allows you to 
switch to another QuickBooks edition, such as 
QuickBooks Pro. 

To remove the File drop-down menu from the screen, click 
anywhere outside the drop-down menu or press the Esc 
(Escape) key. 
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Step 2: Click Edit on the Menu bar and the following drop-down 
menu appears: 

 
 
 
 
 
 
 
 
 
      
 
 
 

From the Edit drop-down menu, you can undo, cut, copy, 
paste, and edit information entered in QuickBooks.  

The Edit menu changes based upon which windows are 
open. For example:  

§ Click the Home icon to display the Home page, then 
click the Purchase Orders icon in the Vendors section 
to display the purchase order form.  

Step 3: Click Edit menu. Now the Edit menu will appear as 
follows: 

 
 
 
 
 
 
 
 
 
 
 
       
 
 
 

 
QuickBooks has an 
onscreen calculator. 
 

 
The Edit menu now 
contains: New 
Purchase Order, 
Duplicate Purchase 
Order, Memorize 
Purchase Order, and 
Change Account 
Color.  
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Step 4: Click Lists on the Menu bar to display the following drop-
down menu.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

From the Lists drop-down menu, you can access various 
lists of information. 

§ Chart of Accounts. A list of accounts used to record 
transactions. 

§ Item List. A list of inventory items that you buy and sell 
or a list of services provided to customers. 

§ Payroll Item List. A list of items related to payroll 
checks and company payroll expense such as salary, 
hourly wages, federal and state withholding, 
unemployment taxes, Medicare, and Social Security. 

§ Templates. A list of templates for business forms, such 
as invoices and purchase orders. 

§ Memorized Transaction List. A list of recurring 
transactions that are memorized or saved. For example, 
if your company pays $900 in rent each month, then 
the rent payment transaction can be memorized to 
eliminate the need to reenter it each month. 
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Step 5: Click Accountant on the Menu bar to display the drop-
own menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

From the Accountant drop-down menu, you can access 
features accountants use for client services. 

§ Accountant Center. A central location to organize 
accountant tools in QuickBooks. 

§ Chart of Accounts. A list of accounts used to record 
transactions. 

§ Client Data Review. This tool streamlines client file 
cleanup tasks. 

§ Make General Journal Entries. An onscreen journal for 
the accountant to make correcting and adjusting 
entries. 

§ Reconcile. The accountant can reconcile client bank 
statements. 
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§ Working Trial Balance. The accountant can use this to 
review beginning balances, adjustments, and ending 
balances. 

§ Set Closing Date. The accountant can set the closing 
date for the accounting period. 

§ Condense Data. This feature permits the accountant to 
create a period copy of a client’s QuickBooks files. For 
example, an accountant might create a period copy of 
a client’s 2015 accounting year to provide to the IRS. 

§ View Conversation List. QuickBooks 2015 introduces a 
Client Collaborator feature to facilitate accountant and 
client communication. 

§ Online Accountant Resources. QuickBooks offers 
desktop and online accounting solutions. See Section 3 
of this text for more information about QuickBooks 
Online Accountant. 

Step 6: Click Company on the Menu bar to display the drop-down 
menu. 

From the Company menu, you can: 

§ Access company information and, for example, change 
the company name. 

§ Set up users and restrict access to certain parts of 
QuickBooks. 

§ Change your password. 

§ Set up budgets and use planning decision tools. 

§ Create a To Do List and Reminders. 

§ Access the Chart of Accounts and onscreen Journal. 

§ Enter vehicle mileage. 

§ Set up mobile access to access your QuickBooks data 
online on your mobile device.   
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Step 7: The next four items on the Menu bar display drop-down 
menus listing various activities related to the four major 
types of transactions for a company: 

§ Customer 

§ Vendor 

§ Employee 

§ Banking 
 

 

Some of the frequently used activities on these drop-down 
menus can also be accessed from the Home page. 

Step 8: Click Reports on the Menu bar to display the list of reports 
that QuickBooks can create for your company. These 
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reports can also be accessed from the Report Center by 
selecting Reports on the Icon bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

Step 9: Click Window on the Menu bar to display the drop-down 
menu. From this menu you can switch between windows 
to display onscreen.  
 
 
 
 
 
 
 
 
 
 



  Chapter 1  Quick Tour of QuickBooks  1.39 

©McGraw-Hill Education, 2016 

Step 10: If not already selected, select Create Purchase Orders from 
the drop-down menu.  

Step 11: Close the Create Purchase Orders window by clicking the 
x in the upper right corner of the Create Purchase Orders 
window.  

QUICKBOOKS REPORTS 
 
Preparing reports is an important aspect of an accountant’s role. 
QuickBooks offers many different types of reports that can be 
customized to meet business needs. To prepare a QuickBooks trial 
balance report for Rock Castle Construction: 

Step 1: To view the Report Center, select Reports in the My 
Shortcuts section of the Icon bar.  

Step 2: Select Accountant & Taxes from the report categories on 
the left of the window. 

Step 3: Select Carousel View. 

Step 4: Select Trial Balance report. 

Step 5: Select the date range: 11/01/2019 To 11/30/2019. 
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+ 
To keep your 
Desktop neat, 
consider 
adding a 
Folder to your 
Desktop:  
QB Excel 
Reports 
Templates. 
Then 
download the 
Excel Reports 
Templates to 
that folder. 
 

Step 6: Select Run icon.  

Step 7: Prepare the Go Digital Excel Reports Template for Chapter 
1 as follows: 

§ Go to www.My-QuickBooks.com. 

§ Select the QB2015 link. 

§ Download the Go Digital Excel Reports Template for 
Chapter 1 to your Desktop. 

§ Open the Excel workbook.  

§ Select File > Save As.  

§ Enter file name:                                        
YourLastName FirstName CH1 REPORTS 

§ The filename extension should be: .xls or .xlsx  

§ Close the Excel workbook. 

Step 8: To export the Trial Balance from the QuickBooks software, 
with the Trial Balance report displayed on your screen, 
select Excel.  

 

 

 

 

 

 

 

 

 

 

 

 

Total Debits equal $1,061,566.46. ✓
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Step 9: Select Create New Worksheet.  

Step 10: When the following Send Report to Excel window  
appears, select Replace an existing worksheet.  

Step 11: Click the Browse button and select your CH1 REPORTS 
Excel file.  

Step 12: From the drop-down list, select the sheet: CH1 TB.  

Step 13: Click the Advanced button.  

 

 

 

 

 

 

 

Step 14: Uncheck Space 
between columns.  

Step 15: Uncheck Include 
QuickBooks Export 
Guide worksheet with helpful advice.  

Step 16: Select On printed report and screen.  

Step 17: Click OK.  

Step 18: Click Export.  

Step 19: When the following Export Report Alert window appears, 
select Do not display this message in the future.  
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With some 
Excel versions, 
you may be 
asked to close 
the workbook 
before you 
can insert 
another 
report. 
 

 

 

 

 

 

 

Step 20: Select Yes.  

Excel should open on your screen with your QuickBooks Trial 
Balance inserted.  

Step 1: Select the 1 REPORTS sheet tab.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Mark the report sheet you completed by inserting an “x”. 

Step 3: Save your CH1 REPORTS Excel workbook using the 
filename: YourLastName FirstName CH1 REPORTS.  
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Step 4: (Optional) If you would like to print the Trial Balance 
report, with the Trial Balance displayed on your 
QuickBooks screen, select Print to print the report. 

Step 5: Click the x in the upper right corner of the Trial Balance 
window to close this report. If asked if you would like to 
memorize the report, click No.  

 

QUICKBOOKS HELP MENU 
 
QuickBooks has several Help features to assist you in using 
QuickBooks software.  

Step 1: Click Help on the Menu bar to display the drop-down 
menu of Help features.  

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

+ 
See Correcting 
Errors in 
Appendix C: 
QuickBooks 
Issue Resolution 
for information 
about fixing 
errors. 
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Help features of QuickBooks include: 

§ QuickBooks Help with search, relevant topics, and 
online forum 

§ Ask Intuit contains online support for Intuit, Community, 
and IRS results to your questions 

§ Quick Start Center with videos about using QuickBooks 

§ Learning Center Tutorials offer tutorials to learn 
QuickBooks 

§ Support links to online QuickBooks support and resource 
centers 

§ Year-End Guide offers assistance in closing the 
accounting period 

§ App Center: Find More Business Solutions links to a 
website containing small business software applications 

§ Register QuickBooks permits you to register your 
QuickBooks software 

Step 2: Select QuickBooks Help from the Help menu, and the 
following Have a Question? window will appear. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

At the top of the window, you can type in your question. 
Results can be viewed as: 
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! 
Ask your 
instructor if 
you should Go 
Digital or use 
paper 
printouts. See 
Appendix D 
for more 
information 
about going 
digital.  
 

§ Answers in Help. Links to relevant help topics appear in 
this section. 

§ Answers from Community. This acclaimed QuickBooks 
online forum permits QuickBooks users to share 
questions and answers to QuickBooks questions. 

§ Still need help? This option includes Ask our community 
of experts where you can post your question to 
QuickBooks’ live community of experts and superusers.  

Next, you will use QuickBooks Search to search for 
information about exporting QuickBooks reports to Excel 
software.  

Step 3: In the Search field, type: export to Excel.  

Step 4: Click the search icon.  

Step 5: Select Export a report to Excel. 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 

Step 6: Read about how to export QuickBooks reports to Excel. To 
print the Help information, click the Print icon, then select 
your printer and click Print. 

 



1.46   Exploring QuickBooks with Rock Castle Construction  

©McGraw-Hill Education, 2016 

 
.QBM files, 
QuickBooks 
movable files, 
also called a 
portable file, can 
be used to email 
or move a 
company file to 
another 
computer. 
 

 
Two types of 
QuickBooks files 
used by 
accountants are: 
1. Accountant’s 

Copy Transfer 
File (.QBX) 

2. Accountant’s 
Copy Working 
File (.QBA) 

SAVE COMPANY FILES 
 
Two types of QuickBooks files you will use are: 

1. .QBW file. The QuickBooks working file in which you can 
enter accounting data and transactions. 

2. .QBB file. The QuickBooks backup file used to move a 
QuickBooks file to another computer or if the working file 
(.QBW) fails. The data files provided for you with this text are 
.QBB files. Because .QBB files are compressed, the .QBB file 
must be restored (unzipped) using QuickBooks software. 
Unlike Excel files, for example, .QBB files cannot be opened 
by clicking on the file.  

The .QBW file is the only QuickBooks file in which you can enter 
data and transactions. When you enter transactions into a .QBW file, 
the information is automatically saved. The typical workflow for a 
business is to use the .QBW file to record transactions and 
periodically back up to a .QBB (backup) file.  

A sound disaster recovery plan includes a backup system. For 
example, a good backup system is to have a different backup for 
each business day: Monday backup, Tuesday backup, Wednesday 
backup, and so on. Then if it is necessary to use the backup file and 
the Wednesday backup, for example, fails, the company has a 
Tuesday backup to use. Furthermore, it is recommended that a 
business store at least one backup at a remote location. 

Typically, the backup file is used only if the company’s working file 
(.QBW) fails. Then the backup file (.QBB) can be restored and used. 
So it is important that the backup copy is as up to date as possible in 
case it must be used to replace lost company data. The backup file 
(.QBB) is compressed and must be restored to a working file (.QBW) 
before you can use it to enter data or transactions. 

For your backup schedule, you will save a .QBB file at the end of 
each chapter, exercise, project, or case. 

To complete your Computer Accounting with QuickBooks 
assignments, you can use one of the following two approaches: 
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Workflow

QBB 
DATA STARTER FILE 

QBW

START

Open QB Software

QBB

Restore CH 1 DATA 
STARTER QBB File

Complete 
Assignments

Create QBB 
Backup File

Complete Next 
Assignment Using 

Same QBW File

Create QBB 
Backup File

Repeat

END

QBB DATA STARTER FILES QBB BACKUP FILES

My QBB 
BACKUP FILE 

My QBB 
BACKUP FILE 

 
If you have 
questions about 
which approach 
to use, check 
with your 
instructor. 
 

1. Workflow Approach. Saves you time if you are using the same 
computer. 

2. Restart & Restore Approach. Required if you are switching 
computers. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WORKFLOW APPROACH 
Use the Workflow approach if you will be using the same computer 
to complete your QuickBooks assignments. Just as in a business 
workflow, since you are using the same computer, you can continue 
to use the same .QBW file. You will make backups at the end of each 
chapter and exercise. You will only use the backup if your .QBW file 
fails you. 

Look for this Workflow icon for instructions for this approach. 
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RESTART & RESTORE APPROACH 
Use the Restart & Restore approach if you will be moving between 
campus and home computers. When you finish your QuickBooks 
work session, you will back up to a .QBB file in order to move the 
QuickBooks file to another computer. 

When you restart your work session on another computer, you will 
restore the backup (.QBB) file. 
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There are actually two ways you can do this: 

§ Restore your own .QBB file. The advantage to using your own file 
is that your name is already included in the company name. 

§ Restore the .QBB data file that comes with the Computer 
Accounting with QuickBooks text (available on CD or download 
from the Online Learning Center).  There is a .QBB data file for 
each chapter except chapters 8, 10, and 13. The advantage to 
using the data file provided with your text is that you avoid 
carrying forward any errors in your company file.  

Look for this Restart & Restore icon for instructions for this approach. 

QUICKBOOKS BACKUP (.QBB) FILES  
Look for this Backup icon to remind you to back up your QuickBooks 
file. 

To save a backup (.QBB) file: 

Step 1: With your QuickBooks file (*.QBW) open, click File. 

Step 2: Select Back Up Company.  

Step 3: Select Create Local Backup.  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 
Step 4: When the following window appears, select Local backup.  

Step 5: Select Next.   

Backup
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+ 
Instructions 
for backing up 
QuickBooks 
files are also 
contained in 
Appendix B: 
Back Up & 
Restore 
QuickBooks 
Files. 
 
 
You can 
schedule a 
backup at 
regular 
intervals or 
every time 
you close a 
QuickBooks 
company file. 
 

 
Backup files 
can also be 
saved using 
QuickBooks 
Online 
Backup 
service. 

+ 
Create a QBB 
Backup Folder 
on your 
Desktop. Then 
save your 
QBB files to 
that Desktop 
folder.  
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
Step 6: If the following Backup Options window appears, to make 

it easier to find your backup files, click the Browse button. 

Step 7: Select Desktop.  

Step 8: Click OK to close the Browse for Folder window. Click OK 
again to close the Backup Options window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 9: Select Use this Location if a QuickBooks warning window 
appears.  
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Step 10: Select Save it now.  

Step 11: Select Next. 

Step 12: When the following Save Backup Copy window appears, 
the Save in field should automatically show: Desktop.  

Step 13: Update the File name field as shown to: YourName 
Chapter 1 (Backup). Depending on your operating system 
settings, the file extension .QBB may appear automatically. 
If the .QBB extension does not appear, do not type it.  

Step 14: The Save as type field should automatically appear as  
QBW Backup (*.QBB).   

Step 15: Click Save.  
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Step 16: When the following message appears, click OK.  

 
 
If you are using the workflow approach, leave your .QBW file open 
and proceed directly to Exercise 1.1.	
 

If you are using the Restart & Restore approach and are ending your 
computer session now, use the following directions to close the 
company file and exit QuickBooks. When you restart, you will 
restore your backup file to complete Exercise 1.1. 

 
Your windows 
settings 
determine 
whether the 
.QBB displays 
automatically. 
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CLOSE COMPANY  
 
To close a QuickBooks company file: 

Step 1: From the Menu bar, select File. 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2: Click Close Company. 

If the company file is left open when you exit QuickBooks, the next 
time anyone uses the QuickBooks software, the company file might 
still be open, permitting access to your company accounting records.  

EXIT QUICKBOOKS 
 
To exit QuickBooks, click the S in the upper right corner of the 
QuickBooks window, or click File menu > Exit. 
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WWW.MY-QUICKBOOKS.COM 
Go to www.My-QuickBooks.com to view additional QuickBooks 
resources including Excel Reports Templates, QuickBooks videos, 
and QuickBooks Hot Arrows and Hot Topics. The Hot Topics can be 
viewed on your computer or tablet and feature frequently used 
QuickBooks tasks. Bookmark www.My-QuickBooks.com for your 
future use. 

MULTIPLE-CHOICE PRACTICE TEST 
A Multiple-Choice Practice Test for Chapter 1 is on the Computer 
Accounting with QuickBooks Online Learning Center at 
www.mhhe.com/kay2015. Try the Practice Test and see how many 
questions you answer correctly.  

EXTRAS! 
Section 3: Quick Guide contains quick, easy step-by-step directions 
for frequently used QuickBooks tasks, including correcting errors. 
You can find Quick Guide at the back of your text  

Quick Check is a list of the reports and documents that you are to 
deliver to your instructor for grading. You can find the Chapter 1 
Quick Check at the end of the chapter or online at 
www.mhhe.com/kay2015. Staying organized saves time. Use the 
checklist to organize your reports, checking off the reports as 
completed. Then include the checklist with your reports for grading. 

Go Digital using Excel templates. Download Excel templates at 
www.My-QuickBooks.com. See Appendix D: Go Digital with 
QuickBooks for instructions about how to save your QuickBooks 
reports in Excel or your QuickBooks documents in PDF. Check with 
your instructor to see if you should go digital.  

LEARNING ACTIVITIES 
Important: Ask your instructor whether you should Go Digital to 
complete the following assignments  (see Appendix D: Go Digital 
with QuickBooks) or print.   
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EXERCISE 1.1: PRINT FINANCIAL STATEMENTS 
 
SCENARIO 

While working at your computer, you notice Mr. Castle heading 
toward you. Adding another stack of papers to your overflowing 
inbox, he says, “I need a  profit & loss statement and a balance 
sheet for November as soon as possible. I haven't seen any 
financial statements since our former accountant left.”   

As he walks away, Mr. Castle calls over his shoulder, “From now 
on I'd like a P&L and balance sheet by the first of each month.” 

TASK 1: OPEN COMPANY FILE  

WORKFLOW 
 If you will be using the same computer and the same Chapter 
1.QBW file, you can use the Workflow approach.  

§ If your Chapter 1.QBW file is not already open, open it by 
selecting File > Open Previous Company. Select your Chapter 1 
.QBW file. If a QuickBooks Information window appears with a 
message about the sample company file, click OK. 

§ Add YourName Exercise 1.1 to the company name by selecting 
Company menu > My Company.  

RESTART & RESTORE 
If you are not using the same computer that you used in Chapter 1, 
you must use the Restart and Restore approach.  

§ Restore your Chapter 1 Backup.QBB file using the directions in 
Appendix B: Back Up & Restore QuickBooks Files.  

§ After restoring the file, add YourName Exercise 1.1 to the 
company name by selecting Company menu > My Company. If a 
QuickBooks Information window appears with a message about 
the sample company file, click OK. 

  

+ 
See Section 3: 
Quick Guide 
for step-by-
step 
directions. 
 

 
The company name appears on reports and can differ from the file name. See 
Quick Guide for additional instructions for changing the company name. 
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TASK 2: PRINT PROFIT & LOSS STATEMENT 
The Profit & Loss Statement (also called the Income Statement) lists 
income earned and expenses incurred to generate income. 
Summarizing the amount of profit or loss a company has earned, the 
Profit & Loss Statement is one of the primary financial statements 
given to bankers and investors.   

Prepare the Profit & Loss Statement for Rock Castle Construction by 
completing the following steps: 

Step 1: Click Reports in the Icon bar. 

Step 2: Select type of report: Company & Financial. 

Step 3: Select report: Profit & Loss Standard. 

Step 4: Select the date range: Last Month. The Dates field will 
now be: 11/01/2019 To 11/30/2019. Select the Run icon. 

Step 5: Export the report to Excel using the Go Digital Excel 
Reports template or print the report as follows: 

§ Click the Print button at the top of the Profit & Loss 
window. Select Report. 

§ Select Portrait orientation.  

§ Select Fit report to 1 page(s) wide. 

§ Click Print to print the Profit & Loss Statement. 

Step 6: Click the x in the upper right corner of the Profit & Loss 
window to close the window. 

 
 
 
Step 7: Highlight the single largest income item appearing on the 

Profit & Loss Statement for the month of November. 

Step 8: Highlight the single largest expense item appearing on the 
Profit & Loss Statement for the month of November. 

Net income is $16,507.99. 

+ 
See Appendix 
D: Go Digital 
with 
QuickBooks 
for 
instructions.  
 

✓
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TASK 3: PRINT BALANCE SHEET 
The Balance Sheet is the financial statement that summarizes the 
financial position of a business. Listing assets, liabilities, and equity, 
the Balance Sheet reveals what a company owns and what it owes. 

To prepare the Balance Sheet for Rock Castle Construction at 
November 30, 2019, complete the following steps: 

Step 1: From the Report Center window, select type of report: 
Company & Financial. 

Step 2: Select report: Balance Sheet Standard. 

Step 3: Select date range: Last Month with Dates field From 
11/01/2019 To 11/30/2019. Select the Run icon. 

Step 4: Export the Balance Sheet to Excel using the Go Digital 
Excel Reports template or print the Balance Sheet. 

Step 5: Click the x in the upper right corner of the Balance Sheet 
window to close the window.  

 
 
 
 
Step 6: Highlight the single largest asset listed on Rock Castle 

Construction’s November 30, 2019 Balance Sheet.  

TASK 4: SAVE EXERCISE 1.1 FILE 
Save a backup of your Exercise 1.1 file. Use the file name: 
YourName Exercise 1.1 Backup.QBB. See Appendix B: Back Up & 
Restore QuickBooks Files for instructions. 

Leave your QuickBooks .QBW file open if you are completing 
Exercise 1.2 now. 

WORKFLOW 
If you are proceeding to Chapter 2 and using the same computer, you 
can leave your .QBW file open and use it for Chapter 2. 

RESTART & RESTORE 
If you are stopping your QuickBooks work session and changing 
computers, you will need to restore your .QBB file when you restart. 

Total Assets equal $652,098.45. 

Backup

✓
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EXERCISE 1.2: QUICKBOOKS HELP  

In this exercise, you will use QuickBooks Help to obtain additional 
information about using QuickBooks. 

Step 1: Use QuickBooks Help to search for an answer to the 
question: When do I use a backup vs. a portable company 
file?  

Step 2: Print the information you find.   

Step 3: Circle or highlight the information on the printout about 
differences between backup files and portable files. 

EXERCISE 1.3: QUICKBOOKS HELP  

In this exercise, you will use QuickBooks Help to obtain additional 
information about using QuickBooks. 

Step 1: Use QuickBooks Help to search for information about a 
QuickBooks feature of your choice. 

Step 2: Print the information.  

Step 3: Circle or highlight the information on the printout that you 
find the most useful. 

EXERCISE 1.4: WEB QUEST  

Intuit Marketplace offers a variety of apps that work with QuickBooks 
data. To explore some of these apps, complete the following steps. 

Step 1: Go to the website: apps.intuit.com. 

Step 2: On the Intuit Apps website, what apps do you find the 
most useful? Print information about the app you would 
rate the highest.  

 
 
 
 
 
 
 
 

 
Due to Web 
page updates, 
websites in the 
Web Quests 
are subject to 
change. 
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CHAPTER 1 QUICK CHECK  
NAME:  
INSTRUCTIONS: 
1. CHECK OFF THE ITEMS YOU COMPLETED. 
2. ATTACH THIS PAGE TO YOUR PRINTOUTS. 
 

  CHAPTER 1 
£ * Trial Balance  
£  Export to Excel Help 
  EXERCISE 1.1 
£ * Task 2: Profit & Loss Statement 
£ * Task 3: Balance Sheet 
  EXERCISE 1.2 
£  Help Topic Printout 
  EXERCISE 1.3 
£  Your Choice Help Topic Printout 
  EXERCISE 1.4 
£  Intuit App Printout 
   

  
 
 

REFLECTION: A WISH AND A STAR  
Reflection improves learning and retention. Reflect on what you have 
learned after completing Chapter 1. 

A Star:  

What did you like best that you learned about QuickBooks in 
Chapter 1? 

A Wish:  

If you could pick one thing, what do you wish you knew more about 
when using QuickBooks?  
 

! 
Ask your instructor if 
you should Go Digital 
(Excel* or PDF) or use 
paper printouts. 
 

* Export these reports to 
CH1 REPORTS Excel 
template.  
 
Items without * cannot be 
exported to Excel. Such 
items must be saved as PDF 
or printed. Ask your 
instructor. 

NOTE TO INSTRUCTORS 
* Identifies assignments 
exported to Excel that can 
be speedgraded using the 
QuickBooks QuickGrader.  

✓

Download Go Digital Excel templates at www.My-QuickBooks.com. 

* Export these reports to CH1 REPORTS template.  
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PROJECT 1 LARRY’S LANDSCAPING 
 
SCENARIO 

Larry’s Landscaping just hired you as an accounting consultant to maintain its 
accounting records using QuickBooks financial software. The QuickBooks 
company file for Larry’s Landscaping has already been created and transactions 
have been entered. Your assignment is to complete the following steps to export 
reports to Excel and then email them to the finance director at Larry’s.  

To complete this project, download the Go Digital Reports Excel template for 
Chapter 1 at www.My-QuickBooks.com. To ensure your success at going digital, 
carefully follow the instructions provided in the Excel template. 

1. Restore the Project 1 data file (.QBB file) for Larry’s Landscaping. Update the 
Company Name to: YourName Project 1 Larry’s Landscaping. 

2. Download the Go Digital Reports Excel template for Chapter 1. Save the Excel 
file using the file name: YourLastName FirstName CH1 REPORTS. (If you have 
already downloaded the Chapter 1 Reports Excel template for prior Chapter 1 
assignments, you will use that template for this project assignment.) 

3. Using the Chapter 1 Reports Excel template, export to Excel the Profit & Loss 
Standard for Larry’s Landscaping for the last fiscal year, October 1, 2018 
through September 30, 2019. Highlight the single largest income item. 
(Important: Remember to uncheck Space between columns, uncheck Include 
QuickBooks Export Guide worksheet with helpful advice, and select Show 
report header: On printed report and screen.) 

4. Export to Excel the Profit & Loss Detail for Larry’s Landscaping for the last fiscal 
year, October 1, 2018 through September 30, 2019. Which type of landscaping 
service produces more revenue for Larry’s: Installation or Maintenance & 
Repairs? Highlight your answer. 

5. Export to Excel the Balance Sheet Standard for Larry’s Landscaping for the last 
fiscal year ending September 2019. Highlight the largest liability on the balance 
sheet. 

6. Export to Excel the Balance Sheet Summary for Larry’s Landscaping for the last 
fiscal year, ending September 2019. Highlight the largest asset. 

7. Mark the reports completed on the 1 REPORTS sheet. Save your Excel file. 

8. Save a .QBB backup of your work.  
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PROJECT 1 QUICK CHECK  
NAME:  
INSTRUCTIONS: 
1. CHECK OFF THE ITEMS YOU COMPLETED. 
2. ATTACH THIS PAGE TO YOUR PRINTOUTS. 
 

  PROJECT 1 
£ * Profit & Loss Statement, Standard 
£ * Profit & Loss Statement, Detail 
£ * Balance Sheet, Standard 
£ * Balance Sheet, Summary 
   
   
   
   
   
   
   
   
   
   
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

! 
Ask your instructor if 
you should Go Digital 
(Excel* or PDF) or use 
paper printouts. 
 

Download Go Digital Excel templates at www.My-QuickBooks.com. 

* Export these reports to CH1 REPORTS template.  

NOTE TO INSTRUCTORS 
* Identifies assignments that 
can be speedgraded using 
the QuickBooks 
QuickGrader.  

✓



1.62   Exploring QuickBooks with Rock Castle Construction  

©McGraw-Hill Education, 2016 

NOTES: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


